Model Paper -05

1. URL T el BIH 42T 82 What is the full
form of URL?

a. Uniform Resource Locator

b. Unique Resource Locator

¢. Uniform Register Locator

d. None
2. Computer &1 5P BT 571dT 22 Who is
called the father of computer?

a. Ram Tomlinson

b. Mark Zuckerberg

¢. Charles Babbage

d. Tim Burners Lee

3. Artificial Intelligence BFGR BT Bt
gfié B ate gfga TPl aeAls 22 Artificial
Intelligence is the technology to make
computer intelligent like human
intelligence?

a. True

b. False
4. Text Editor fordl 282 WIsel difdsae, wifswrs
vd R B & fAeuah faar Aar e ?, Text
Editor is used to create, modify and store
any text file?

a. True

b. False
5.CalcProgram ® SBI9 g1a1 82 Is it impressed
in CalcProgram?

a. True

b. False

6. CalcPivotTable &T TWe Hdl 22 6.
Supports CalcPivotTable?
a. True
b. False

7. RTGS &I WM B &l 82 7. Who
maintains RTGS?
a. SBI
b. RBI
c. NPCI
d. None
8. Online voting $-7a4d &1 7 2 Is online
voting a gift of e-governance?
a. True
b. False
9. CPU & T T5ictcs A I &t gt &2
Which memory is closest to the CPU?
a. RAM
b. Main Memory
c. Secondary Memory
d. Cash Memory
10. Anti Fishing Virus ff20T 310 & gardl 3am
T 82 Anti Fishing Virus protects us from
phishing attacks?
a. True
b. False
1.Mozila FirfoxdT & What is Mozilla
Firefox?
a. Td&H
b. de§ER
c. To&HdRd®R
d. PIg el
12. Computer &1 7fd P! a1 A AU &2
Computer speed is measured in watts?
a. True
b. False
13. ATM Pin, Mobile Banking Pin 311f¢ g€eid
&1 TifEe?

a. True



of C2C?
a. Customer to Care
b. Customer to Customer
c. Customer to Core
d. None
15.MS Word # fas& 857 &1 5[ arEfSiee 100%
g1 8? In Ms Word, the zoom width of a
page is 100% by default?
a. True
b. False
16. Aadhaar Card # fisaq fEfSic @@ 82, How
many digits are there in Aadhaar Card?
a. 10
b. 1
c. 12
d 14
17. ATM & Ugat 6 ff5ic @ & Ft vgam a)dt &2
, Bank is identified by the first 6 digits of
ATM?
a. True
b. False
18. USSD &1 el HiH &laT 82 USSD ka full form
hota hai?
a. Unstructured Supplementary Service
Data
b. Unstructured Service Data
¢. Unique Supplementary Data
d. None
19. BASIC &1 el BiH 82 What is the full form
of BASIC?
a. Beginner's All-purpose Symbolic
Instruction Code
b. Beginner's All-purpose System
Instruction Code

d. None of these
20. NABARD &1 TTTAT fasaA Hi? Who
established NABARD?
a. S.N.Verma Committee
b. Swaminathan Commission
c. B.Sivaraman Committee
d. None of these
21. MMID &1 %el HiH 82 What is the full form
of MMID?
a. Mobile Money Identifier
b. Mobile Money Identification
c. Mobile Money Identity
d. None of these
22. IC &7 3MIfasBR fdaa far? Who invented
IC?
a. faaTfleq
b. HIdb USET
c. e it
d. PIs &l
23. feis) 3iifoy fas) e B & faie anéepe &t
18Xl 82 23. What is the shortcut key for
closing the LibreOffice window?
a. Ctrl+Q
b. Ctrl+O
c. Ctrl+W
d. Ctrl+X
24. AT & e Brege & wabit Bt et Srar 82
a. BRYRITIAH
b. $-AeT a4
C. ST TIIA
d. S-aH9
25. RS 37 2ifth UTH el & 25. The

Computer Gets Its Power

a. AUAtIfa
b. Ygard



26. Calc, Impress, Excel Ol Bisafie wiym &2
Calc, Impress, Excel are all spreadsheet
programs?

a. &t
b. Ield

27. BHISH®D! A ST B UfshaT 82 What is the

procedure for carrying out commands?
a. i
b. IR

c. fGaifsm

d. uastRgfeT

28. Tf31e1 ARG BT 31T fR 52T 22 . The size
of virtual memory depends on?

a. T3S W
b. SETIIWR

c Roradaw
d. It

29. fpan foeilarse @ v WTaTSe odr 87 29.
How many kilobytes make up one
megabyte?

a. 128

b. 1024

c. 256

d. 512

30. ATHTSC...... BT B 82 The website is a
collection of......?

a. Tfthad

b. W

c. 3TNReR
d. ag s

31. fafeifaa 7 & fou aqg A Saa sqe fBarsa

Eld 82 The website is a collection of......2
a. HEY S S ATR
b. HI3, & &8, X
c. HI3H, B 98, TeAe R

FYR q Fgeelar s, 39 ... HEd 82 32,
The computer to which the user's
computer is connected for access to the
Internet is called......?

a. Alcgd
b. &Y

¢ GRER
d. TR

33. 3YE & 313¢YC H BUFAOL........gRT fasam
SITdT 8?2 33. The conversion of input to
output is done by?

a. UR®eT
b. AHRY
c. WA
d. "ty
34. Twitter ! <&l SATdT &2
a. E-Commerce
b. Blogger
¢. Micro Blogging
d. None of these
35. UPI # | FIT 82 What is | in UPI?

a. Internet
b. Import
¢. Interface

d. None of these
36.Facebook W 3iftiha B aR # fbar wiel
3YelS B Thd 82 What is the maximum
number of photos | can upload to Facebook
at once? What is the maximum number of
photos | can upload to Facebook at once?
30
40
100
20

o N T o



can make on Facebook?

a. 3000

b. 4000

c. 5000

d. oIS AT TEl
38. Instagram WX s1feipad fora gug 6t difsar
3UeilS 6 Tehd 82 What is the maximum
length of video that can be uploaded on
Instagram?

a. 20 JdpbUg

b. 40 dpUg

c. 60 ddUS

d. PIsTEl
39. M-Commerce &t [B3Td BT 2ft? What is
the word that usually appears underlined on
a web page?

a. Bill Gates

b. Tobin

c. Kevin Duffey

d. None of these
40. BHIM app §RT T & & fdaan 99T grau
PR AP &2 , How much money can be
transferred in a day through BHIM app?

a. 20000

b. 30000

c. 40000

d. No Limit

41. Windows 10 TTFedR & Iffcl BT
HPBIUBR fbad I 82 Who holds the
proprietary rights to the Windows 10
software?

a. IBM
b. Apple
¢. Microsoft

the bank charge interest?
a. SHBITWR
b. U
c. gFl
d. ST dPIS Tet
43, 79} P-4 v IR 82
a. THTH 3T
. TSIg Thlde dsY
T HIeRE
. gfiew
44, TIT A 8 51t AR W A9 U457 R
Yaifdd wefid 21 22 44. What is the

word that usually appears underlined on

o 0 T

a web page?
a. EH A Udl
TS ERWIcid
U HEcqof a3
. T AT 2leg
45, fauw T 82 What is odd?
SMTP
POP
FTP
IMAP
46.Td SII35R- A browser-
a. 3UERAC A BAdE B3 T YIITH 8
b. JTTEC Id BT HITH &
C. A9 W AT S A YAIT b 51
1T HIIH &
d. 3ud aHt
47.7e0s BIsd &1 fEwhiee Bise vaM 82 .

What is the default file extension of

o n T

c o T Y

notepad file?
a. .npd
b. .txt
c. .atf



the following was the first network?
a. ARPANET
b. NSFnet
c. Vnet
d. Inet
49. T W 31 319ds foid gO STR[ACH T
7 31R 3MaRYPdT USA W 39N A9 STThT
HeNe[ A A YERIAT Bdl 82 A program
that helps you create documents you've
written and go back and revise them
when needed?
a. Home row key
b. Tool bar
c. Folder
d. Word Processor
50. Libreoffice Writer # TTSSaR &I 8155/20
P Bt 2ATdepe HI 8?2 Is there a shorteut
key to hide/show the sidebar in
Libreoffice Writer?
a. Ctrl+4
b. Ctrl+5
¢. Ctrl +F5
d. Ctrl+Shift +F5
51. fauEt & 3wy W 5t 305 Hefla 8t 8, 38
PEA 82 . The image displayed on the
desktop of a window is called?
a. AR
b. drelUwR
. 3TeT BAaT
d. fdvsisast
52. f6d UPHR Ft LG fSarsd9 & v WA A
faset 311 T WX A€ @ ST HBA? . Which
type of storage device cannot be moved
from one place to another?

a. g s

d. 9T3rs
53, TEATSS A BISRIT® 50 B &1 Aféepe Fi
2?. What is the shortcut key to insert
hyperlink in the slide?
a. Ctrl+H
b. Ctrl+K
¢. Ctrl+D
d. ETEWRicid &4 Tt {2 51 apar 8
54. fA 9 & feie fasa aivedarR &1 &bt
Aare
a. MS-Excel
b. MS-Word
¢c. BothAandB
d. None of these
55. fiw A foa fame & grRI 7N & 7fvidia
TR w1 Afdfifeica H2ar & 2 Which of
the following symbol represents the
mathematical operator of
multiplication?
a. =
b. >
c /
d X .
56. ST BIE BrYe PIs RN fiie Bear 2 dl a8
HB?&EWET%? When a computer
prints a report, it is called output?

o

Soft Copy
b. Hard Copy
C. Rough Copy
d. None of these
57. Presentation A T saidgli-ia 2ile Baetrd!
&?. An electronic sheet in presentation
is called?
a. lss
b. $-%Iss
c. 30U



3ifeieha¥ A 82 . What is the maximum
value of zoom Percentage in MS-Power
Point?

a. 100%

b. 300%

C. 200%

d. 400%

59. favgIst 3iTRfT fTen A faraa Fele deT
Eld 82. How many control buttons are
there in Windows operating system?

a. IR
b. UTa
c. Bg
d. dhH

60. ¢ FHHIS YT AT 3T P Bel A Bt 22 .

Where does the cut command save the

information or data?

a. WY
b. fariudis
c. WISHIEIUT I3
d. fi
61. Keyboard TR geT Function key gt 82
There are total Function keys on the
keyboard?
a. 10
b. 100
c 12
d 1
62.5eX YIeRdl fGad Bd 7T STaT 82 When
is Computer Literacy Day celebrated?5

foarer

a. 14 feamr
b. 22 fcamr
c. 2feamr

. pIHIA

3R 3fIhaTss O
AR A

. fafdema

o

o N T

64.3<¢ & Ua A Ug Tedidyl &1 9 fasga su
£

a.Higher text transfer protocol
b.Higher transfer text protocol
c.Hybrid text transfer protocol
d.Hyper text transfer protocol

65. CPU # dglet, AW 3R diar & ar gfie

Aae? » What are the control, memory and
third unit in CPU?

a. WIS
b. URRR
c. 3M3TYe
d. 3RMfeH/dle
66. TIUHT 3R GeAT & feie rgeR & fasa wir
T YRIPT 5T ST1d1 82 Which part of the
computer is used for calculation and
comparison?

a. f&pgfic
HigH
ALU
Pererge
67. CPU 3iR I/0 & el el & e & &
fAif3id AT 82 Who controls the movement
of signals between CPU and I/0

a oo

a. &ld g
b. ALU



68. 9 & & PIH-U1 FFIR &1 ot wrf T8
22 Which of the following is not a basic
function of computer?

a. 31T Pl U BT

b &< &l T BT

C. 1Y Pl TfTbR BT

d 31T BT &R BT

69. 4l Ul Y F1 450 TP &2 What is the main
component of CPU?

a.gld gfac

b.AHIRT
c.3fAfes |l gfic
d.a ot

70. BRI B! {8 YHR Hi gfg FHt dsm &t 1 82
What type of intelligence has been given to
the computer?

a.HId

b.pfEH

&
d3=

71. M@ A Shfe BT [ B arelt gell db
PIH-AT AT? . Which was the first bank to
introduce credit card in India?

a. ICICI

b. HDFC

c. State Bank of India

d. Central bank of India

72. Twitter R URE &Xd I fban a8 o
dPba 22 . How many words can be
written while posting on Twitter?

a. 40
b. 50
c. 140

73. Libre office writer ® fdsdl 2leg & ?Nﬁ A
& 60 i dt andepe Ht T B2

a. Ctrl +Arrow Right

b. Ctrl +Arrow Left

c.  Ctrl +Shift +Arrow Left
d. None of these

74. ABRS &1 G0 H 82 What is the full form
of ABRS?

a. Aadhaar-based Remittance Service
b. Advance based Remittance service
c. Aadhaar board Remittance Service
d. None of these

75. U sAdzii-db fSarsd 51t 3¢ B sTBHA §
Pa¢ B EC MAY HaT 82 An electronic
device that processes data by converting it

into information?

a. PYXR
b. &g
c. TR
d. ST d Pis Tl
76. Cell Pointer @\ 37Teil Tle R & 5T & fae
Pl 2éepe &1 82 What is the shortcut key
to move the Cell Pointer to the next seat?
a. Right Arrow
b. Alt+Pagdown
¢. Ctrl+Pagdown
d. Cntrl+Home
77. Y abed BI 3199 | e & foe fasa wwis
T 3UNT AT 51T 82 Which command s
used to merge two workbooks?

a. W3
b. W abed



78.LibreOffice writer A f&AT TRITE A5 fHA
TS Sb B Bl ATEhe Hi 22 78. Is there a

shortcut key to break line without
changing paragraph in LibreOffice
writer?
a. Shift+Enter
b. Ctrl+Enter
¢. Enter
d. All of these
79. Impressﬁt@?ﬁiﬁéﬂfaﬂﬁiﬁ ATéPHe Bt
272 Is there a shortcut key to insert hyperlink
in Impress?
a. Ctrl+M
b. Ctrl +K
¢. Ctrl +N
d. None of these
80. Impress A FeT A< fdsa? 1d 82 How many
menus are there in Impress?
a. 10
b. M
c 12
d 13
81. S8 7 A9 61 TR BIseT PT Tl 0 T
8? What is the extension name of the file
saved in Impress?
a. .odt
b. .ods.
c. odp
d. .odi
82. Impress R TIT W51 307 B Ht
ATépe Ht T 8?
Ctrl+H
Ctrl+M
Alt+N
Ctrl+N

o n T op

When creating any presentation in
Impress, what is its default title
name?

Docuent 1

Presentation 1

Untitled 1
. IMP1
84. BUI & IS A A New FHIS & 3R

PH-PIF A YI-HHIS AMfAST & 2 Which

sub-commands are included under

o 0 T w

the New command in the File menu of
Impress?
a. Master Document
b. Formula
C. Spreadsheet
d. All of these
85. Impress ® 394 R¥le & HHis BeT R
fierdt 82 Where is the open remote
key command found in Impress?
Edit
File
Insert

o 0 T w

. None of these
86. Impress & Save As 1 2léde 6 F=IT
&2 What will happen to the
shortcut of Save As in Impress?
Ctrl+S
F12
Ctrl+Shift+S
Ctrl+F12
87. Impress 9 fdl i weieM @Y fda
PiAe A TRl o Gebd 82 In which

format can | export any presentation

o 0 T w

from Impress?
a. PDF



d. All of these
88. Impress @ dr&: 5T & fae 3q fast
gATd BB1? Whom would you choose
to go out of Impress?
a. Ctrl+X
b. Ctrl+Y
c. Ctrl+Q
d. All of these
89. Impress ® Past Special &1 2éee 6t 22
. What is the shortcut key for Past
Special in Impress?
a. Ctrl+Shift+Vv
b. Ctrl+Vv
c.  Shift +V
d. None of these
90. Impress ﬁﬁﬂ‘ﬂ%&i’ﬁgﬁﬂaﬁ!ﬂﬂﬁ
& foiv améepe &t 1 BI? To duplicate

any text in Impress, press the
shortcut key?
Ctrl +Shift + 2
Shift +F3
Ctrl +F3
Alt +F3
91.  Impress R {659 HHis | Find and
Replace &1 SN Il AT Ear 2.
Which command opens the Find and

o 0 T @

Replace dialog box in Impress?
a. Ctrl +F
b. Ctrl+H
c. Alt+F
d. All of these
92. Impress ® Past Unformatted Text &
feie B It eanéepe Hi g B2
a. Ctrl+Shift+Vv
b. Ctrl+Alt+Shift+V

93.

94.

95.

96.

97.

98.

Slide Shorter View &His fid A= #
fietdt 22 . In which menu is the Slide
Shorter View command available?

a. File
b. Edit
c. View
d. Insert

Twitter &1 311Rf5e A9 FIT AT? What
was the original name of Twitter?

a. Twttr

b. Twtter

c. Twiter

d. Tweetr

Maximum Lenth of a tweet?

a. 280
b. 300
c. 400

d. None of these

Firefox SRIT & ? . What is Firefox?
Operating System
Search Engine
Web Browser

o 0 T w

Messanger

Linux &RIT 82 What is Linux?
Operating System
Hardware
Utility Software

o N T w

None of these
MQTT Stands for- MQTT Stands for-
a. Maessage Queuing Telemetry Transport
b. Message Queuing Tele Transport
c. Message Quick Telementry Transport
d. None of these



Office?
a. 1024
b. 1048576
C. 65536
d. None of these
100. Gmail ? A fFA ge A fFa A=A 22 .
Where do the messages saved in
Gmail go?
a. Sent box
b. Draft




Model Paper -06

. didleT (VPN) FIT8? What is VPN?

a. Ig3Td Ufecids Acadb

b. I UTSAIC qeadh

c. I3 yTeHdt Acad

d. a3ra fiie Jeads

. FIP@SIATE ......... 8?2 FTP is basically

a. T79Hi &1 3< (Protocols)
b. Language
C. dI BN
d. a9 us
. SSL gRT Rfatd SMTP BAFA] BlidbaT sTdT
2?2 SMTP connections secured by SSL are
called?
a. SMTPS
b. SSMTP
¢. SNMP
d. SSLM
. {79 2 B-a1 £ A ©39 BT UPEE 82 Which
of the following is not a part of an e-mail
address? Which of the following is not a
part of an e-mail address?
a. PRAH
b. SHTAH
C @
d
. WREE ........ GHH G AT 8? Router
performs a function similar to ........ ?
a. Hub
b. Switch
c. Bridge
d. Repeater

6. 0S| fiwpig Aide A Fe fdharleR gidl 82

How many layers are there in the OSI
reference model?
a. 4

b. 5

c 7

d 9
7. Rﬁzﬁmzﬁraaﬁmmw%v Internet

is the most famous example of?

a. WAN

b. LAN
¢ MAN
d. SAN
8. frafifad & P1H-a1 vh AqgER T 8 2.

Which one of the following is not a web
browser?

a. gBRl

b. T

. kP AdR

d. 3T

9. UEAT Gef $5 AT? Was the first search
engine?
a. TP

b. AcEBY

c. IBRY

d. 3t

10. 79 & PH-T1 39 A9 TRk & TaP! Yehia
& &, 579 R dgarsedt gifeen 6t At 22
. Which of the following refers to the
address of the web server on which the
website is hosted?
a. EEWRfd®
b. URL
¢. DNS



12.

13.

14.

15.

16.

17.

.

Going from one web page to another is
called?

a. Hfam

Interconnection of Network

LAN\

MAN

WAN

Facebook T 3-1A ATse 82 Facebook is
an e-commerce site?

a. gat

b. Icid

Snapdeal B S-BTHT ATST 8?2 |Is Snapdeal
an e-commerce site?

a. get

b. Icid

HTML TSl act 282 WHisel 82 HTML files
are just text files?

a. et

b. Ieid

KYC &I Hdeld? Meaning of KYC?

a. Know your customer

e o o w

b. Know Your Character

¢. Both of above

d. None of these

fiw A Pr-t i WfepT A Hfere WD St
& 2. Which of the following key is used
for spelling check?

a. F3

b. F5

18.

19.

20.

21.

22.

23.

TeiTss Yesmse B fiie 7Y & feag @
.......... T PR? . To print a slide handout,
select .......... from the menu?

a. View > Handout

b. File > Handout

c. File > Print

d. View > Print

UMNAG App W 39aiedl Qamsi ALPG afdd
Wt 2nfieT 8?2 Are LPG service included in
the services available on UMNAG App?
a. &l

b. Tad

UTR@rse Trsst 4 37 @ earafriferd faar
ST IHaT 82 . Which of the following can
be included in Power Point slides?

a. fimR
b. A%
c. d&T
d

gld 82 Which symbols are used in
hexadecimal number system?

a. 0-7

b. 0-9

c. 0-9A-F

d. None of these

RAM & fiafeifaa & & feamnribT gar 82
Which of the following is used in RAM?
a. PSR

b. THl BRI

c. JaIH A

d. cifsieed

fAmfeifda A 4 c-DAC gRT fAfAd yRa &
Y& YR FRYR & B A fAb! AFT 5T
22 2. Which of the following is considered



a. PARAM Yuva
b. PARAM Padma
c¢. PARAM 8000
d. PARAM Ishan

24, T3 qeR fGed 61 3R &2 Binary

25,

26.

27.

28.

number system is based on?
a. 2

b. 4

c. 6

d 8

aﬁaﬂqgr:m%? . What is the full name of
Van?

a. du eRarAcad

b. dT8g BRAT Acddh

C. IR TRAT Acad

d. STH I PIg Tt

B & WYeh HI3H &Y 1St PRt 40 af
udf ot T ot | S AHT IS T AT? . The
body of the mouse used in the computer
was made about 40 years ago. Was it
made at that time?

a. CogfAAIH &I

b. TATRCD BT

Cc. sHId &l

d. TBST B

WLL &7 312f 82 . WLL stands for?

a. fderse e s

b. fad dlipa ameT

C. dTRed dlidbel o

d. IRRE ST ARTeATST

g UpR & BRI HrEafftd Wbt fear
STAT 8?2 Which type of computer is
mostly used?

a R ITYR

29.

30.

31

32,

33.

34.

d. Hﬁaﬁaiﬁtqa
3h-2aouTE & fae 3MdR R g fife &1

WY B AT 511aT 82 . Which printer is
generally used for desk-type printing?

a. 357 &l fiiex

b. 3T Af¢a iR

c. @R

d. 3WIh # & BI T8l
fafafaa & @ S ot geer senfidt
2[ecTdell 7€ 82 Which of the following is
not an Information Technology term?

a. AERTY

b. 3Uclg

c. IRt HUSRUT

d. HisH

Wy fhg faug & gwefid 2reg 82 . Spam is a
word related to which subject?

a. PR

b. &ell
c. difta
d. dd

7w A & &7-T1 v HRget ug T 82 Which
of the following is not a computer term?
a. TN

b. dTEHRt BIg

c. fau

d. fam

Wmﬁm%, U ... A computer
virus is a....

a. P

b. AR

c. 1C7344

d. FTER 9™

HFR B TYfd BT AT fHAT AT 8? The

memory of computer is measured by?



35.

36.

37

38.

39.

c. CARR&BERI

d. diecd b gRI

PR SRR, N e BY aga Hferd AT
&1 HUSRUT &R TehdT &, BECIT 872 .
Computer hardware, which can store
large amount of data, is called?

a. grIBIF ey

b. &b

c. A3RBEH

d. 30 H A BIg Tal

HFYEX BT eI HEcaqUl HPT 82 The most

important part of computer is?
a. didtg,

b. BidEE

c B

d. iz

. 79 # @ B 9T GTOeRR 2rec aTeA o Wbt

fosa1 SATAT 82 . Which of the following
software is used in word processing?

a. O3-Ad

b. dS-EIPh

c. THUHTS

d. 3

HrYR W T 31 et s, e fead
ot Adt 82

a. fafciem

b. dfer

c W

d. wEd

A9 A 82 . ROM is memory?
. &dd Yed & fee

. &ad feiad & foie

o g ue gl & fafe

. ST BIETE

o))

o 0O T

a. RAM
b. ROM
c¢. CPU
d. CDROM
41. 79 % @ B 1 3113eYe Feb &l 82 Which of
the following is not an output
containing?
a. SHUT TR
b. HIRAMIR
c. TWR-BI
d. ffsiea &
42. fafafad § @ B 4t vh FFgeR &t 1T
&' 8?2 Which one of the following is not
a computer language?
a. BASIC
b. C
c. FAST
d. FORTRAN
43. f75 & @ F rgeR Bt HTIT T8 2?2 Which
of the following is not a computer
language?
a. ST
b. Tl++
c. A
d. Ul
44, 1o 578 FFe’ GHETaT & 9 fFsarfaa wear
2, BEcIIdl & ?. The language which the
computer understands and executes is
called?
a. ARG HTET
b. #Hftt HTaT
C. TH TSIl HTST
d. 3WIh A & &I T8l

45, “HA139” 82 "Mouse” is?



c. TZlEFC'JT@HTSF
d. 3mcqe fSarsq

46. ffsicar Froer fbg fhgia R &rf wear 82

On what principle does the digital
computer work?

a. TUMHET

b. AT

c. faga
d. of>ied fGeaia )

47. 779 ¥ 4 P v HrYgeR 3iTehe) Fi Ffeat

Waf2id BaT 82 . Which one of the
following represents computer data

errors?

a. fIu
b. dTsge
cC. 97
d. fae

48, 9ad STGT YT & 31 areft @rsfen sAqe

fearsa 1T 4t 82 Which is the most
commonly used pointing input device?
a. ¢hdd

b. CrIUS

c. TATDA

d. |38

49, Libreoffice Impressﬁﬁfﬁl‘q Zoom HIssT

fésaT 82 . What is the minimum zoom
size in Libreoffice Impress?

a. 5%

b. 15%

C. 10%
d. 3000%

50. SH®H T 8? What is Facebook?

a. Td&H
b. S35
c. BAOR

52.

53.

54,

55.

56.

P YhAd 82 Can you use Ctrl + F Find
command in Libreoffice?

a. True

b. False

Delete G3ft R & fohd aEB BT BaER
fierar 22 Delete key deletes the
character on which side of the cursor?

a. g¢

b. ¢

c. ol

d. ®IsTEl

Libre Office writer A rado &1 & 2Aiddhe
&1 IT 82 What is the shortcut key to do
rado in Libre Office writer?

a. Ctrl+y
b. Ctrl+z
c. Ctrl+R

d. Ctrl +shift+R

LAN, MAN, WAN Aead & UBR 82 . LAN,
MAN, WAN are the types of network?

a. Her

b. Ierd

TEe & It 291 B v IR A AR FA F
fote ctr+A 3 faHt IR SaMT U372 How
many times Ctr+A has to be pressed to
select the entire table in Writer at once?
a. THER

b. aleR

c. dHeER

d. IRETR

Impress Libre office &1 TP Waie WU
2. Impress Libre is a presentation
program for office?

a. True

b. False



stands for?

o

Uninterrupted Resource Locator
b. Unique Resource Locator
¢.  Uniform Resource Locator
d. Uniform Router Location

58. Internet mmﬂﬁ&'m%?
a. WAN

b. MAN

¢. LAN

d. None of these

59. fig & B a1 Meldia fafia gie &t -
AT &1 GfaeTe Y Bar 82 Which of the

following protocol provides e-mail

facilities between different hosts?

a. SMTP

b. FTP

¢. TELNET
60. 7@ & Ai7 sae filex BT HBR 82 Which of
the following is a type of non impact
printer?

a. Daisy wheel Printer

b. Laser Printer

¢. Line Printer

d. All of these
61. Window + L gﬁﬂzﬁrmz’m%? Windows

+ L key is used?

a. To Lock desktop
b. Shut Down

C. Restart

d. Log off

62. Hard Boot f78 & & I 82 Which of the
following is Hard Boot?
a. ST BRYR Bl GoRT Y fepar 51N
b. BRI Bl G5R b eIl BT 3R T 64 W
QIRT &IE BT

63. Desktop W 31 & feiv o Be B 82, Is
there a shortcut key to get on Desktop?

a. Winodw Key+S

b. Window Key+E

¢. Window Key+D

d. Window Key +0O
64.Windows 10 &I fooa aff aier far a2 In
which year was Windows 10 launched?
a. 2012
b. 2013
c. 2014

d. 2015
65. Writer # Ac1 751 fas1Te fasa A & fiietan 82
In which menu is the mail merge wizard
found in Writer?

a. File

b. Tools

c. Format

d. Form
66. Libre Office Writer ﬁgq?ﬁssaaﬁa;
feie 2méepe &6t 82 What is the shortcut key to
insert super script in Libre Office Writer?

a. Ctrl +Shift+B

b. Ctrl+Shift+P

c. Ctrl+ Shift +A

d. None of these
67. FDDI &1 el BiH 82 What is the full form
of FDDI?

a. Fiber Distributed Data Interface

b. Fiber Distributed Data Interconnection

¢. File Distributed Data Interface

d. None of these
68. ARCNET T T ATH 2

a. Advance Resource Computer Network

b. Attached Resource Computer Network



69. OSl WE[(T?I‘H%? What is the full form of
osI?

a. Operating System Connection

b. Open System Internet Connection

¢. Open System Interconnection

d. All of these
70. IMAP BT 71 TLH0T 82 Is there a newer
version of IMAP?

a. IMAP2
b. IMAP4
¢. IMAP3
d. None of these

71. WWWW BT G BIH 82 What is the full
form of WWWW?
a. Worm World Wide Web
b. Word Worm Wide Web
¢. World Wide Web Worm
d. All of these
72. MAC Address fosaq faie B1a12? How
many bits is the MAC address?
a. 32fde
b. 48fde
c. 128fse
d. oMt

73. f79 & & IR giafioM &1 YR T2 22,

Which of the following is not a type of
wireless transmission?

a. Radio waved transmission

b. Micro wave transmission

c. Optical fiber

d. Infrared wave transmission
74. Writer B 29eT 3~0¢ A &6l AMbe Hi 82, |
there a shortcut key to insert a table in
Writer?

a. Ctrl+Fn

d. None of these
75. Libre Office Writer A ®ie 5~0¢ &1 &t
2méepe &t 82 What is the shortcut key to
insert a comment in Libre Office Writer?

a. Ctrl +Alt+A

b. Ctrl +Alt +C

c. Ctrl +Alt +B

d. Ctrl+ Shift +C
76. 381 A 2e< Siew & foie B 4l e 6t
T &¥a 82 Which shortcut key is used to
open the text box in Impress?

a. F

b. F2

c. F3

d. F4
77. Impress ﬁﬂﬁﬁfﬂ?ﬁﬁﬁﬂmﬁiﬁ
?fl'liril'ﬁ"‘f? , Which menu will you choose to
insert a chart in Impress?

a. File

b. Insert

c. Tools

d. Format

78. 31T 3197 fEa18d FT IMEI ek UaT H32 &
fete &7 a1 Pis SR Fa 82
a. *#06%#
b. *#05#
Cc. *06#
d. None of these
79. IMPS &4 [% §311? , When did IMPS start?
a. 2010
b. 2012
c. 2015
d. 2009



withdrawn in AEPS?
a. 5000
b. 10000
¢c. 50000
d. 100000
82. 518 39 B1E Fal feefle wa o fEedte fasar
B3 F-Cl B8l Il SATAT 82 , When you delete
a message, where does the deleted message
go?
a. Trash
b. Spam
¢. Outbox
d. All of these
83. Trash & et foba féAY db TEa1@? How
long does mail stay in Trash?
a. 20
b. 10
c. 30
d. IS AT TE
84. WORM T e WiH 82 What is the full
form of WORM?
a. Write once Read Many
b. Write One Read Many
¢.  Write on Random Memory
d. None of these
85. fisel wirss WX 5T &t Aéde Bt FaT e ?
What is the shortcut key to go to the
previous slide?
a. Page Down
b. Page Up
c. Esc
d. All of these
86. Libre Office U Teilb2i ATTEaR 82 Libre
Office is an application software?

a. True

dPha 82 How many people can be added to a
group on Whatsapp?

a. 500

b. 256

c. 250

d. 1000
88. feisl 31f%a Powh A v AT ¥ 31feiban qof
P 4T fopat gldt 82, What is the maximum
number of characters in a cell in LibreOffice
Calc?

a. 5413

b. 1254

c. 3254

d. 32767
89. ISDN f&d UK BT Aead 82
. el gy
. |fdbe feafenm

Afdpe T

. eIt
90. WWW R 21 d Ugaq & feaie g d d p
A1 45 MBI 3T €ldT 82 Which of the
following is the main protocol used to access
data on the WWW?
a. HTTP
b. HTML
C
d

Q

o O T

FTP
. SMTP
91. 3113CE® TN &RT 82 . What is Outlook

Express?

a. §I3R

b. & &5H

c. Tfex

d. E-AdT FATSe



fiber optic cable measured?

a. O
b. #pE
c. fAHt
d. 3w
93. {215 Beiet YeT A o 7t faoan 511 Gebar? .
What cannot be done from the Windows
Control Panel?
a. TTEHIBRMA TA™T
b. i BIfFERA
c. WIUE 318AT
d. TR ST BRAT
94.POS BT 31f 82 POS stands for?
a. Point of Service
b. Permanent Server
c. Partition of Server
d. Point of sale
95. Calc Bis2fie A 51 BIE FeR esU HA &
A< T TeATsTHE FITIEAT & When typing a
number in Calc spreadsheet, what is the
alignment of the cells??
a. doe
b. MeC
¢. AR
d. it
96. AMIa: §-6md fGad 313 §d 82 With
what is e-commerce generally

associated?

a. difs3n ST
b. ®a 3R fdwa
R CEEIGH
d. 3cire Reg &
97. T T H 3-Ad Bl 3iftisan ST & fier
gHd 82
a. Multiple

d. Only Three
98. FAeAE & GRT BRI Metbiet IRAPT
glar8? Communication protocol is used
by internet?
a. HTTP
b. TELNET
c. UTP
d. FTP
99. URI &1 guf 372f 8? What is the full meaning
of URI?
a. Uniform Resource Identifire
b. Universal Resource Identifire
¢. User Resource Identifire
d. None of these
100. QR BIS BT 312f 82 What is the meaning
of QR code?
a. Quick Result
b. Quick Response
¢. Quick Restore
d. None of these



